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[bookmark: _Toc399143827]Acknowledgments / Dedication Pages – optional.
The author wishes to thank….in the acknowledgements page, most students type a sentence or so thanking instructors, fellow students, parents, or others that have helped them craft their senior thesis, collect and analyze data, proofread, or even pay for college. This is up to you. It is not necessary to have an acknowledgements page

The numbering for pages in this “front matter” section, before the table of contents generally uses small Roman numerals. The first page (title page) counts as a page, but no number appears at the bottom of the page. Pagination styles and options are on the “Insert” tab.

[image: ]Note that there is a “section break below”. You need to have formatting elements “showing”. In order to see formatting you need to click the “paragraph symbol” on the Home tool bar to activate it. (see above). 

Section breaks can be added by activating the “Page Layout” tab and clicking on the “Breaks” drop down menu. There are several options. The one below is a “Next Page” section break.
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The table of contents can be updated automatically by right clicking on the table itself and choosing from the options: Update Field. You may only wish to update page numbers, or you may update the entire table if you’ve added new section headings. 

To place new items in this Table of Contents, you must add a new Heading. You might first insert a page break (click on insert and then select break). Then type a word or phrase you’d like to use to label your new chapter/section, such as “Literature Review”. Press return. Highlight the line containing the word you just typed. Then either select from the drop down menu of styles (upper left corner of your screen…see figures below) and select Heading 1, or press Alt, Shift and the left arrow simultaneously. 
[bookmark: _Toc399143829]
List of Figures (required if there are more than 4 figures/ tables/ maps, etc. in thesis)
Figure 1: Map of Six Flags Amusement Park.  You may want to put the source or URL	5
Figure 02: Pie Chart of Expenses. Source: xx	6
Figure 03: Random Table	7

The list of figures is much like the Table of Contents in terms of how it functions. However, the table only searches for text that is in the “caption” style. You can update it just like a table of contents, by right clicking on the table itself. 
[bookmark: _Toc399143830]
Abstract (required for thesis)
Insert your abstract here. The abstract should be written last and must capture your entire argument or thesis in a few words. It shouldn’t be flashy, but it can have a catchy, short sentence to start it off. You may have a sentence or two of introduction. It must be as succinct and informative as you can make it. Include a brief explanation of your research question, data and methods, and findings. 

350 words or 2450 characters max for theses.
No bold, italics or underlined words.
Make sure it’s still Roman numeral below…
Abstracts can be hard to write if you do not have a disciplined composition style.
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[bookmark: _Toc399143831]Introduction (Chapter 1 if theses)
Begin typing your introductory paragraphs here. Remember that this very well may be the last section of your paper that you write. It may be a good idea to have a working introduction as you begin your paper, but a re-write of your introduction is a very important component of the process.
Remember that the introduction should contain a few introductory remarks that should get the readers attention. You may then move on to making very obvious what your research question is and the resultant thesis statement or hypothesis. Your research question tends to be broader than your hypothesis. If you are writing an essay style research paper, then you may simply have a thesis statement.
This body text is in 12 point, Times New Roman font. The paragraph is double spaced. Arabic number 1 is at the bottom of this page.  Each new paragraph begins with an indentation of 1-tab or 5 spaces. The paragraphs are left justified and have a “ragged” right hand border. Quotes over three text lines long should be single spaced, block formatted and indented by ½ inch on both right and left. An example of block quoting is in the paragraph below:  
Although many wizards have claimed otherwise, there is a way to preserve life long beyond the 82 years common to most wizards. One of the most unique ways was found by alchemist Nicholas Flamel some 400 years ago. According to Flamel (1742, 422):  note the Chicago Style reference….more on that below.
The best way to live well beyond your years and to endanger young wizards such as Harry Potter, is to create a stone that can be used by bad guys like “you know who” to seek out.  With such a stone, evil wizards can go on an unending killing spree, while seeking out multiple ways to keep from really dying so this book and movie series will go on for an eternity.
Once you’ve done your block quote, you may continue on with the rest of your essay or research paper.  Rules on “block quoting” vary by discipline.  Check with your professor or advisor.
For theses, consult the guidelines produced by the graduate studies office.

Here’s a link to the 2014 edition:
http://www.csun.edu/sites/default/files/FormatGuidelines-8-2014-b.pdf

[bookmark: _Toc399143832]
Literature Review
You don’t have to call your literature review “Literature Review”. Some call it “Background” or somehow blend it in with the introduction. It’s generally a good idea for you to call leave it this way in the 490 course, simply because it aids your instructor and the assessment team with finding and evaluating your lit review.
Remember that the literature review accomplishes at least three tasks:
1. It demonstrates that the author (you) have a working knowledge of prior, important research on your subject.  Simultaneously, it helps your reader “catch up” on prior research.  You MUST tell the reader an integrated story about what has already been written about your topic, and how that research was conducted.
2. It places your research in the context of what has already been written by others on the subject.
3. It makes the case for your research by showing what has NOT been written on the subject….and that’s why the world needs your research.
The literature review should include not only previous research on your topic, but also other related research. You may have a section on your topic by non-geographers, a section reviewing the literature dealing with related topics that informs your research. You may even devote a few paragraphs to the methods found in other research that helped inspire your choice of methodology.

[bookmark: _Toc399143833]
Data
You may want a section detailing why and how you obtained the data that you were using. You may want to point out the source, potential problems with your data, how you went about getting it….etc. You may also want to make quick reference to any additional studies – references that helped you figure out your data gathering process. Secondary data sources should always be cited. 
[bookmark: _Toc399143834]Subheading: Heading Two
You may want to have an occasional subheading if your section or chapter is particularly long and you believe that it needs to be broken into sections. Don’t go overboard with multiple subheadings and sub-subheadings.
[bookmark: _Toc399143835]
Methods
You may combine the data and methods sections. Sometimes they are separate. In the more traditional, historical geography, or humanities based papers, the methods section may be missing altogether …as might be the data section.
I’ve also inserted a few figures in this section to show you how to place a figure in a document. Most papers have figures of some sort, perhaps tables or charts or perhaps maps or photographs. Inserting them and labeling them correctly is important. Below is a map from the internet that I have labeled figure 1.
[image: 2006map]
[bookmark: _Toc398710753]Figure 01: Map of Six Flags Amusement Park.  You may want to put the source or URL.  Note that this caption is centered on the page, with the graphic.  You may want to have the text wrap the image if it is smaller.



In the section below, you’ll see inserted a table and then a chart. Each of the captions are placed immediately below the table or chart, and they are numbered sequentially. Exceptionally large tables, maps, graphics or anything else that substantially interrupts the flow of the text document might be better placed at the end of the paper in an appendix. There is an appendix in this template document at the end.
Below is a chart that illustrates how another figure might look in this document.
[image: 3d_pie_graph.gif (8022 bytes)]
[bookmark: _Toc398710754]Figure 02: Pie Chart of Expenses. Source: xx
On the page below there is a table labeled Figure 3. If you would like to add your own, copy and paste it from Excel or your graphics software into this document. You can copy and paste right over the existing figures, but you’ll need to update the caption. 
To insert a caption, simply place your cursor below your graphic/map/etc. and right click on the image or graphic.  You’ll notice a popup menu – select from it “insert caption” and follow the prompts.  You can also select an image and click on the References tab, and select caption from the options on that tool ribbon.  The dialog box that appears (see Figure 4 below) should automatically number the caption for you. You simply have to place your cursor after the number and type what you want in the response box. Figure 03: Screen capture showing the location of the insert caption button.


Make sure you go back to your list of figures table (above on page 3) and update it by right clicking on the table itself each time you add a new image and caption.
[image: table, work-relate injuries by age at date of injury and sex, year ended 30 June 2002, as reported by 30 September 2002. ]
[bookmark: _Toc398710755]Figure 04: Random Table

Return to normal paragraph style.
[bookmark: _Toc399143836]
References
In this section, you should place your references…or your bibliography. Nothing should appear in here that does not appear in the text of your research paper, and vice versa. This includes source materials used for maps, tables, graphics, etc. References should appear as they do below for most geography courses.  You may ask your instructor if they prefer another style, but the one below is the Chicago Style, that is used most often by leading publications in American Geography. You should consult the AAG style sheet and it can answer most questions regarding citations: http://www.csun.edu/~sg4002/courses/300/AAG_style_sheet.pdf.  The Chicago Manual of Style is also available on line should you have additional questions: http://www.chicagomanualofstyle.org/home.html
Luckily for you, later editions of Microsoft Word have a citation tool that works reasonably well.  It formats citations and creates bibliographies for you.  Sometimes this tool creates the citations slightly different than what your instructor might expect (SO ASK!), but most often instructors are looking for consistency and completeness.
The first set of references (immediately below) have been lifted from the AAG style sheet. Please note that that they are alphabetized, single spaced, with a hanging indent and an extra space between references. The first is from a book and the second two are from journals and the last is a web reference.  
The SECOND set of references was built using MS Word’s citation tool.


[bookmark: _Toc399143837]Sources Cited (AAG Style Sheet)
Adams, J. 1776. The Wealth of Nations. London: Sage Press.

Smythe-Jones, X. 1998. Copyediting: The authoritative tome. Cambridge, MA: Small Room Press.

Smythe-Jones, X., L. Emmetson, and Q. Garraty. 1995. The art of copyediting:Nitpicking never ends. American Journal of Copyediting 27:167–89.

United States House of Representatives. http://www.house.gov/science/asrar_021199.htm (last accessed 26 February 2001).



[bookmark: _Toc399143838]Using Microsoft Word to Create Citations and Bibliographies
Below is a short tutorial on using the citation and bibliography tools in Microsoft Word.

Any time you need to put in a citation (after a quote, or statistic, or when you are using someone else’s idea), then click on the References tab, and pick your favored citation style.  In the image below, Chicago is selected because Geographers use that a good deal…but there are a number of styles available, including APA, MLA, Turabian and Harvard.  You can change it later if you need, and all will be updated automatically.

[image: ]
Figure 01: References Toolbar

After you have selected the style, place your cursor where you want to insert your citation, and then click the Insert Citation button.  For each NEW citation, you’ll have to enter the source material (book, article, web site, etc.)  The image below 

[image: ]
Figure 02: Dialog Box demonstrating information that might be entered for a book.

After you click OK, at the place you indicated, the appropriate style of citation will appear.  In this case (see page 7 above), a parenthetical reference about Harry Potter was inserted..but since it was a quote, it needed a page number.  The name “Flamel” appears twice, so we only need the date and page number.

To modify the reference, click on the reference itself, and then click on the small down arrow at the end of the reference.

[image: ]
A drop down menu will appear.  From the options, chose “Edit Citation”.  A small dialog box will appear and from that (in this case), you would choose to suppress the Author’s name, and the Book Title, but you would INCLUDE some page numbers from where the quote was lifted[image: ].  See image at the left.


The fake paragraph below, will include a few additional citation sources, just so you can see what they look like and the resultant bibliography can have a reasonable number of citations.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Donec ut magna dictum tortor viverra consequat. Suspendisse pellentesque lobortis magna nec pretium (Graves 2014). Nunc finibus rutrum dolor, quis vestibulum sapien. Vivamus eu ipsum eleifend, blandit augue eu, commodo metus. Fusce luctus mattis tortor, non malesuada elit iaculis quis. Quisque nec ullamcorper quam (City Clerk, City of Los Angeles 2010). Mauris aliquam lorem ut massa faucibus, ac euismod nisl suscipit. Suspendisse efficitur tempus odio ut pellentesque. 
Pellentesque consequat consectetur posuere. Pellentesque congue neque maximus volutpat molestie. Fusce tempus, velit eget congue lacinia, eros neque porta arcu, ac ullamcorper lectus quam eu mi. Donec ornare egestas ullamcorper. Sed vitae ultrices neque. Nullam tempus suscipit purus, quis blandit ipsum (Los Angeles Times 2011). Donec luctus euismod neque, ac malesuada mi placerat et. Suspendisse vitae sollicitudin lorem (Toop 1991). 
Nulla diam augue, fermentum nec mauris non, ultricies gravida libero. Sed dignissim tellus nibh, et rhoncus magna varius ac (U.S. Geological Survey 2006). Nunc id rhoncus ex. Cras nulla ligula, consectetur sagittis blandit in, gravida a dui. Morbi at tempor odio. Aenean eget porttitor ligula. Nullam mauris sapien, posuere nec ultrices in, pretium id metus. Fusce ullamcorper convallis varius. Ut in ligula non ligula consequat tincidunt. Donec tellus nisi, mollis ac nisi molestie, elementum pharetra mi. 



Works Cited
City Clerk, City of Los Angeles . "Medical Marijuana Dispensaries." Welcome Page. July 8, 2010. http://cityclerk.lacity.org/cps/pdf/mmregistrationlist2.pdf (accessed November 15, 2011).
Flamel, Nicholas. Alchemy for Beginners. London: Merlin Press, 1742.
Graves, Steven. "Geography as a "Jedi Discipline"." The California Geographer, 2014: 20-29.
Los Angeles Times. "Status of L.A. medical marijuana dispensaries." Los Angeles Times. April 4, 2011. http://spreadsheets.latimes.com/status-of-la-marijuana-dispensaries/ (accessed November 15, 2011).
Sadler, E. J., R. G. Evans, K. C. Stone, and C. R. Camp. "Opportunities for Conservation with Precision Irrigation." Journal of Soil and Water Conservation 60, no. 6 (2005): 371-380.
Toop, David. Rap Attack 2: African Rap to Global Hip Hop. New York: Serpent's Tail Limited, 1991.
U.S. Geological Survey. "Urban Landscape Irrigation with Recycled Wastewater." Completion Report Colorado Water Resources Research Institute, 2006.




[bookmark: _Toc399143840]Appendix
If you should have a great deal of data, tables or maps that are useful for reference, but not necessary in the body of the paper, you should place it in an appendix.
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